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1.  Introduction

ElixirImage for AFP is a full-feature, Windows-based,
bitmap editor that allows you to create and edit black-
and-white or full-color Elixir-format images.

ElixirImage provides the environment and drawing
tools usually found on dedicated graphics
workstations.

Combined with the Elixir Desktop and Converters for
AFP (described in the "ElixirImage environment" sec-
tion of this chapter), ElixirImage provides powerful
features to support your AFP high-speed laser printing
systems.

If you are familiar with GEM versions of ElixirImage for
AFP, you will find the Windows-based version con-
tains the functionality of the GEM versions plus added
features, including a new interface.  If you have never
used ElixirImage for AFP before, you will find Elix-
irImage for AFP highly intuitive and easy to use.

For brevity,  ElixirImage for AFP is referred to as Elix-
irImage throughout the rest of this user guide.  

Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.
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Elixir training

Elixir Technologies Corporation offers training for the
full-range of Windows-based products.  For more in-
formation, contact:

ElixirImage environment

ElixirImage is designed to work with the Elixir Desktop
and Converters for AFP, a Windows-based desktop.
The Elixir Desktop simplifies file conversions and
management by presenting the user with icons which
can be manipulated with simple mouse drag-and-drop
techniques (refer to the Elixir Desktop and Converters
for AFP User Guide for more information).

Other Elixir products that you can use with the Elixir
Desktop are:

ElixirForm for AFP, a Windows-based WYSIWYG
forms creation package that creates boilerplate
forms for conversion to different AFP formats.
You can use image files created in ElixirImage
with ElixirForm forms.

ElixirFont for AFP, a sophisticated Windows-
based font editor that you can use to create or
edit Elixir-format fonts which you can convert to
AFP and other format fonts.  You can convert
black-and-white image files (created with Elix-
irImage) to Elixir fonts by tiling them so that each
tile represents a character in the font.

     Elixir Learning
(805) 641-5900  ext. 6
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Elixir AppBuilder for AFP, a Windows-based
WYSIWYG package that incorporates ElixirForm
for AFP and provides form editing and application
building capabilities.  You can quickly and easily
define a  print operation that merges variable data
from a host data file with fixed resources (such as
overlays and page segments) to produce a print
run.  After job definition, PAGEDEF and
FORMDEF PPFA is generated for use on a vari-
ety of printing and PSF host environments.

Who should use this guide

This guide is intended for users familiar with AFP
graphics resources.

Knowledge of Windows and DOS, especially naviga-
tion through directory and subdirectory structures and
file operations is also required.

Conventions

Most of the following conventions are the same or
similar to Windows conventions.

display conventions

typographical conventions

mouse operations

Display conventions

The Elixir Desktop, ElixirForm, ElixirFont and Elix-
irImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse.  See your Win-
dows manual for more information.

INTRODUCTION
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Typographical conventions

The following typographical conventions are used
throughout this guide and other Elixir product guides.

Keystrokes are shown enclosed in < > (angle
brackets). For example:  

<Enter>

Key combinations are denoted by a plus sign be-
tween keys. For example: 

<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.

Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:

Select [New] from the File menu.

Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected files.

Steps in a procedure are shown in numbered bold
paragraphs.  For example:

1. At the prompt, enter the file name and
extension.

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

Commands you enter at the DOS prompt are
shown in larger text.  Within DOS commands,
variable names and keys you press are shown in
italics.  For example: 

CD \ELIXIR <Enter> 

INTRODUCTION
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Mouse operations

You can perform most operations in Elixir applications
by using the mouse.  The terminology is similar to
other Windows based applications.

Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.

The following mouse related terms are used in this
guide:

click
to momentarily press and release the left mouse but-
ton once.  A right mouse button click is specified
where necessary.  For example,

Click on the right mouse button to finish entering text.

double-click
to click the left mouse button twice in rapid
succession.

drag
to click and hold the mouse on an item and move the
item with the mouse.

drag and drop
to drag an item as above, then release the mouse but-
ton, once the item is positioned over a the area.  If the
selected object is a file and the destination is a direc-
tory, the file copies to the directory.

object
a selectable item on the screen.

open
to point and double-click on an icon -- the effect of this
operation depends on the icon.

point
to move the mouse to position the screen pointer on
an area of the screen.

select
to point to an object and click the mouse -- this usually
highlights the object.

INTRODUCTION

ELIXIRIMAGE FOR AFP USER GUIDE 1-5



<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.

<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.

<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time. 

On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

INTRODUCTION
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Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.

Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

INTRODUCTION
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Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

Organization of this Guide

This User Guide is organized as follows:

Chapter 1, "Introduction," is a brief overview of Elix-
irImage, software and documentation. 

Chapter 2, "ElixirImage basics," describes how Elix-
irImage fits in with your AFP printing system and with
other Elixir products. Basic information required for
using ElixirImage to create an image is described in
this chapter along with pointers to other chapters and
appendices for additional information.

Chapter 3, "Displaying and drawing an image," de-
scribes how a loaded image displays at various mag-
nifications, and how to use the drawing tools available
in ElixirImage.

Chapter 4, "Manipulating images and image areas,"
describes operations you can perform on the entire
image or image areas.

Chapter 5, "Using text and clip art," describes how to
add text to an image, how to create fonts from images
or image portions, and how to create and use clip art.

Chapter 6, "Additional features," contains descriptions
of features that are not directly related to drawing im-
ages but are included as supports for using Elix-
irImage (for example, ruler and merging images).

Appendix A, "DOS directories", lists the directories
used in ElixirImage operations.

Appendix B, "Keyboard shortcuts," lists keyboard
shortcuts for ElixirImage operations.

Appendix C, "Conversion chart," contains a chart
showing supported formats for image conversions.

INTRODUCTION
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Glossary.

Index.

Installation

See the Elixir for AFP Getting Started Guide for instal-
lation information.

Starting ElixirImage

To start ElixirImage from the Elixir Desktop and
Converters:

Double-click on the ElixirImage icon at the right of the
Elixir Desktop.

The ElixirImage main screen displays.

INTRODUCTION
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Figure 1-1. ElixirImage main screen

Alternatively, with the Elixir Desktop displayed, open
the Images folder, then open the Elixir Images folder
and double click on an image file. The above main
screen displays with the image file loaded and dis-
played at the center of the screen.

Exiting ElixirImage

You can exit ElixirImage using any of the following
methods:

Double-click on the Close button at the top left of
any Elixir application.

Press <Alt> + <F4>.

Press <Alt> + <X>.

From the File menu and select [Exit]

INTRODUCTION
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Click on the [X] at the top right corner of the appli-
cation window.

If you have not saved the current image, you are
prompted to do so. 

INTRODUCTION
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2.  ElixirImage basics

This chapter presents an overview of ElixirImage and
brief instructions on how to use it.  The chapter also
includes references to other chapters in this user
guide that include detailed information.

Overview

PC-based graphics packages can create and edit im-
ages in two ways: in bit-mapped format where all
graphics elements created are stored as a collection
of dots, or in vector format where image elements are
stored mathematically.  ElixirImage edits images in
bit-mapped format. 

Other PC-based bitmap graphics formats include
PCX, TIFF, BMP, and AFP Page Segments (PSEG).

Converters in the Elixir Desktop enable you to import
AFP PSEG, PCX, TIFF, and BMP images and convert
them to Elixir format.  When in Elixir format, you can
use ElixirImage to edit the images.  Afterwards, you
can reconvert your edited images back to the original
format or to AFP PSEG, PCX, TIFF, BMP, or Elixir
font formats (see the following figure).

Figure 2-1.  Importing/exporting ElixirImage images

ELIXIRIMAGE

AFP

AFP

PSEG

PSEG

PCX

PCX

TIFF

TIFF

FONT

FONT BMP

BMP
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See the Elixir Desktop and Converters for AFP User
Guide for more information about converting files.

ElixirImage and other Elixir products

The Elixir Suite for AFP products are designed to in-
terconnect.  For example, the following diagram
shows how ElixirImage can be used in a publishing
process.

Figure 2-2.  ElixirImage and other Elixir products

Interconnectivity examples

Any scanner which generates PCX, TIFF or BMP
(Group 4) formats can be used from the Elixir Desk-
top.  The Elixir Desktop can then convert the files to
Elixir format for use in ElixirImage.

Scanners Elixir Desktop

ELIXIRFONT ELIXIRFORM

ELIXIRIMAGE

FONT        
CLIP
ART

FORM
TEMPLATE

SCREEN
IMAGES

 and Converters(to PCX, TIFF or BMP)

AFP Page Segments, 
PCX/TIFF/BMP
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 ElixirImage enables you to create fonts directly from
graphics by tiling the graphic into equal rectangles,
each of which corresponds to a character in the font
(see the "Using text and clip art" chapter).  These
fonts can be imported and edited in ElixirFont and
then converted to AFP format and printed on any AFP
printer.

You can use the Elixir Desktop to convert any AFP
font into Elixir format and then import the font and
place it in an image using ElixirImage.

A powerful feature of ElixirImage is the inclusion of
clip art libraries which are managed by ElixirFont and
used in large graphics projects (see the "Using text
and clip art" chapter).

Graphics created in ElixirImage can be used in Elixir-
Form and AppBuilder to enhance the appearance of a
form.  You can also use ElixirImage to copy forms
from other sources as follows: Scan an existing paper
form into an image file (for example, PCX or TIFF),
convert the image to Elixir format, and use the Elixir
graphic as a template in ElixirForm to be traced over
and created into a new Elixir form (see the "Additional
features" chapter).

ElixirImage features

The ElixirImage main screen is shown in the following
figure.  A blank Work area displays at the center. The
Work area menu bar displays above the Work area,
and the ElixirImage menu bar displays at the top of
the screen.  The main screen also displays a Toolbox
and Toolbar.  The menu bars, the Toolbox, and Tool-
bar are described in the following sections. 

ELIXIRIMAGE BASICS
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Figure 2-3.  ElixirImage main screen

Overview of features

This section gives an overview of ElixirImage features
and refers you to other chapters where features are
explained in detail.

Menu bars

The ElixirImage menu bar contains the following
menus:

System
The options in this menu allow you to configure Elix-
irImage, as described in the "Configuring the system"
section of this chapter.

ELIXIRIMAGE BASICS
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Window
The options in this menu allow you to use the Micro-
soft Windows Multiple Document Interface (see the
"Loading an existing image" section of this chapter, or
your Microsoft Windows User Guide for details), and
to toggle between displaying and hiding the Toolbox
(see the "Toolbox" section of this chapter). 

Help
Select [Release Notes] to view information about this
release at any time.  Note that the Help options in this
menu are not available in this release.

The Work area menu bar contains the following
menus:

File
The options in this menu allow you to load, create,
save and print images, and exit ElixirImage.  There
are also options for merging an image into an existing
image, resetting an image to the last saved state, and
saving an image area.  Operations in this menu are
described in this chapter, the "Manipulating images
and image areas" chapter, and the "Additional fea-
tures" chapter.

Edit
The options in this menu allow you to cut or copy and
paste to the Windows clipboard, copy a screen area
and set the paste mode, and delete all drawings in the
Work area.  This menu also contains the undo and
redo features described in the "Toolbar" section of this
chapter and allows you to select or unselect all ob-
jects.  The Edit menu operations are described in the
"Manipulating images and image areas" chapter.

Image
The options in this menu allow you to view image at-
tributes, expand or contract an image, set the stretch
mode when reducing images, and refresh the screen.
In addition, this menu allows you to access the Extra
operations sub-menu which is described in the "Addi-
tional features" chapter.  Image menu operations are
described in this chapter, the "Manipulating images
and image areas" chapter, and the "Additional fea-
tures" chapter.

ELIXIRIMAGE BASICS
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Tool and Transform
The Tool and Transform menus correspond to the

Toolbox options described in the "Toolbox" section of
this chapter.

ELIXIRIMAGE BASICS

2-6 ELIXIR TECHNOLOGIES CORPORATION

Drawing tools

 Tool options

Go button

 Pattern button

Preview panel

Foreground/Background

Message panel

Tools header



Toolbox

The following figure displays the ElixirImage Toolbox.
Figure 2-4.  ElixirImage Toolbox

The drawing tools at the top of the Toolbox represent
the tools for drawing and editing images or image ar-
eas, and importing text and clip art.  

To use a drawing tool, select the appropriate tool in
the Toolbox or select the tool from the Tool menu.
The drawing tools are described in the "Displaying and
drawing an image" chapter.

The Transform tool is used to apply  transformations,
such as resizing or halftoning, to whole images or im-
age areas and is described in the "Manipulating im-
ages and image areas" chapter.

You can set tool options by clicking on icons in the
Toolbox.  Setting options for a drawing tool is de-
scribed in the "Displaying and drawing an image"
chapter.

The Message panel provides a short description of
any tool selected in the Toolbox.

The Preview panel allows you to preview the option
settings for a drawing tool before you perform any
drawing operations.

You can toggle between hiding and showing the Tool-
box by pulling down the Window menu and selecting
[Tools] or by pressing <F10>.  To move the Toolbox,
click on the Tools header and drag the Toolbox to the
desired location.

Go
The [Go] button is used to apply the transformations
described in the "Manipulating images and image ar-
eas" chapter.

Pattern button
This button shows the current color or shading pat-
tern.  Click on this button to use the colors or shading
patterns as described in the "Displaying and drawing
an image" chapter.

ELIXIRIMAGE BASICS
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FG/BG
The [FG] (foreground) button allows you to select the

color of your drawing tool.

The [BG] (background) button allows you to set a
background color when performing some of the trans-
formation and drawing operations described in the
"Displaying and drawing an image" chapter and the
"Manipulating images and image areas" chapter.  

The [BG] button also allows you to set a background
color when creating a new image.  See the "Creating
a new image" section of this chapter for more
information.

If you are creating a black and white image, click on
the [FG] or [BG] button until the color you want is dis-
played.  If you are creating a full-color image, click on
the [FG] or [BG] button and double-click on a color
from the window that displays.

[FG] and [BG] button operations are described in the
"Displaying and drawing an image" chapter.

ELIXIRIMAGE BASICS
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Toolbar

The following figure displays the Toolbar.
Figure 2-5.  ElixirImage Toolbar.

The Toolbar icons provide the following drawing sup-
ports for the drawing tools:  

Digital ruler
The digital ruler displays the position of the cursor
relative to the top left corner of the Work area.  This
tool is described in the "Additional features" chapter.

Start coordinates
This option displays the coordinates of a point on an
image, relative to the starting point.  This tool is de-
scribed in the "Additional features" chapter.

Magnification/Reduction
This tool allows you to magnify or reduce an image
and is described in the "Displaying and drawing an im-
age" chapter.

Undo/Redo
The Undo/Redo feature allows you to reverse actions
in ElixirImage if the [Number of undo levels] option in
the Preferences dialog box is set to one or more lev-
els.  See the "Usage switches" section in this chapter
for more information.

To undo an operation, you can either pull down the
Edit menu and select [Undo shape] (where shape is
the name of the shape you want to undo), press
<Ctrl> + <Z>, or click on the Undo icon in the Toolbar.
   

To redo an operation that was undone using the Undo
feature, pull down the Edit menu and select [Redo
shape] (where shape is the shape you want to undo),
press <Shift> + <Ctrl> + <Z>, or click on the Redo
icon in the Toolbar.

Drawing modes
These icons (from left to right) allow you to use the re-
place, transparent, and reverse drawing modes de-
scribed in the "Displaying and drawing an image"
chapter.

ELIXIRIMAGE BASICS
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Grid
You can click on this icon to display a grid when using
magnified views of 8x or more.

Message area

The Message area is split into two sections.  The left
section displays the type of image loaded in the Work
area, and operational and error messages.  The right
section provides a description of any icon you place
your cursor over.

Using ElixirImage

This section provides a brief overview of how to use
ElixirImage, including information about setting up
ElixirImage when you first start using it.  If you have
never used ElixirImage, you may want to read all of
this section before you begin.  In it, you will be referred
to other chapters in this User Guide which provide
more detailed information.

Configuring the system

ElixirImage allows you to configure your system and
then save the configuration.

Usage switches

Pull down the System menu and select [Usage
Switches] to display the Preferences dialog box.

ELIXIRIMAGE BASICS
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          Figure 2-6.  Preferences dialog box

Save state on exit
Select this option to save the menu and option set-
tings when you exit an image.

Show quick help
Select this option to see the quick help messages de-
scribed in the "Introduction" chapter.

Confirm file overwrites
Select this option if you want to be prompted before
overwriting a file.

Confirm leaving unsaved work
Select this option if you want to be prompted to save
your work before exiting ElixirImage.

Use Elixir font selector
Select this option if you want to use the Elixir Font Se-
lector when you select fonts for your text.  The Elixir
Font Selector allows you to select non-default font
widths.

Deselect this option if you want to use the Windows
Font Selector when you select fonts for your text.  The
Windows Font Selector allows you to select only Win-
dows default fonts.

See the "Using text and clip art" chapter for more
information.

Keyboard mapping
Select the [Keyboard Mapping] option:

ELIXIRIMAGE BASICS
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Select [None] to use Windows ANSI map-
ping.  If you select this option, you must have
screen fonts mapped to Windows ANSI
mappings.

Select [ANSI to OEM] to remap ANSI key-
strokes to DOS mappings.

Select [KMP] to translate keystrokes using
customized tables.  In most cases, if you
choose the appropriate Country Keyboard
Map and Default Code Page during installa-
tion, you can use this option.

Number of undo levels
Select the number of actions or levels (between 1 and
32) that ElixirImage can reverse when you use the
[Undo] option. 

Xerox catalog name
This option is not valid for this version of ElixirImage.

Configurable colors

From the Configurable Colors dialog box, you can
change the color of grid lines and the color of the loca-
tor box (described in the "Displaying and drawing an
image" chapter).

To display this dialog box, pull down the System
menu and select [Colors].

Figure 2-7.  Configurable Colors dialog box

The current color of the grid lines and the locator box
are displayed.  To change the colors of either the grid
lines or locator box, select the corresponding [Edit]
button to display the Color RGB Editor dialog box.
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Figure 2-8.  Color RGB Editor dialog box

RGB values are Red, Green, and Blue color compo-
nents that are combined to create a color.  Use the
right and left arrows next to each color or click inside
the corresponding box to specify a component value
between 0 and 255.  The Result box shows the results
of mixing Red, Green, and Blue color components.

When you accept your changes by clicking on [OK],
your grid lines or locator box displays in the color
shown in the Results box.

System information

For information regarding your current Windows
screen driver, memory and disk space available, pull-
ing down the System menu and selecting [System
Info] or press <Alt> + <F5>.  The System Information
dialog box displays.

          Figure 2-9.  System Information dialog box
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Reset to defaults

If you change the configuration settings while using
ElixirImage, you can reset the original configuration by
pulling down the System menu and selecting [Reset
to defaults].

Save configuration

To save the current menu and option settings, pull
down the System menu and select [Save configura-
tion] before exiting an image.

Loading an existing image

ElixirImage allows you to load up to two images at one
time.  With the ElixirImage main screen displayed,
load an existing image as follows:

1. Pull down the File menu and select [Load] or
press <F8>.

The Load Image dialog box displays  with an al-
phabetical list of all available images.  If you
elected to install them, the names of demonstra-
tion files are listed.  These are Elixir-format .LP3
files in drive:\ELIXIR\PICS\PRINTER.  To display
.BMP or .PCX images, select them from the filter
window at the bottom of the dialog box.
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           Figure 2-10.  Load Image dialog box.

2. Select an image file and click on [OK].

The file displays in the Work area and the file
name displays in the Work area menu bar.  The
following figure shows the STARS.LP3 file.

Figure 2-11.  Loaded file
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3. To load another image, pull down the Window
menu and select [Another Image] to redisplay
the Load Image dialog box.

4. Select an image.

You now have two images loaded in two separate
windows.

5. Pull down the Window menu and select one of
the following:

[Cascade] displays the images in two sepa-
rate overlapping windows.

[Horiz. tile] displays the images side by side.

[Vert. tile] displays one image above the
other.

Displaying image attributes

To display the image attributes, pull down the Image
menu and select [Attributes] or press <F2>.  The Im-
age Attributes dialog box displays.

Figure 2-12.  Image Attributes dialog box

The Image Attributes dialog box displays the following
information: width, height, name, resolution, color sys-
tem, format, image memory size and memory
available.
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You can select a different resolution only when using
the image in other applications, for example when us-
ing Elixir Desktop converters to convert the file to
other formats (note that the image resolution of the
converted file must be supported by the target printer).
The resolution also affects the size of the image when
importing it into ElixirForm (the higher the resolution,
the smaller the image on the form).

The [Color System] option allows you to convert a
loaded image to [Black & White] or [Full Color], de-
pending on the image you have loaded and the color
system your printer supports.

Editing and saving an image

ElixirImage allows you to edit up to two images at one
time.

To edit a displayed image:

Use the Edit/Drawing tools in the Toolbox.  The
Edit/Drawing tools are described in the "Display-
ing and drawing an image" chapter.

Use the Transform tool or Transform menu to
transform a whole image or image area.  See the
"Manipulating images and image areas" chapter
for more information.

After making changes to an image, you can do the
following:

Pull down the Edit menu and select [Undo
shape], or click on the Undo icon in the Toolbar to
undo the last edit or transform operation.

Pull down the File menu and select [Reset] to de-
lete any changes made since loading or saving
the file.

Pull down the Edit menu and select [Redo
shape], or click on the Redo icon in the Toolbar,
to re-insert the changes you made before you se-
lected [Undo shape].
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Pull down the Edit menu and select [Delete], or
press <Del>, to delete everything in the Work
area.

Pull down the File menu and select [Save], or
press <Ctrl> + <S>, to save your changes to the
current file.  To save your changes to a new file,
pull down the File menu and select [Save as] or
press <F7>.  The Save Image dialog box displays
which allows you to specify a new file name. 

Creating a new image

To create a new image:

1. Pull down the File menu and select [New] or
press F9. 

The Image Attributes dialog box displays.

2. Select the [Color System] option for your
image and click on [OK].

3. Select the color of the background:

If you are creating a black and white image,
click on the [BG] button until the desired
background color displays in the button.

If you are creating a full-color image, click on
the [BG] button to display the Choose Back-
ground Color dialog box, then double-click on
the desired background color.

4. Pull down the File menu and select [New] or
press F9. 
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The Image Attributes dialog box displays.

      Figure 2-13.  Image Attributes dialog box options

The Image Attributes dialog box displays the fol-
lowing options:

Width
Specify the width of the new image in dots.

Note that ElixirImage rounds image widths to the
nearest multiple of eight dots.  

Height
Specify the height of the new image in dots.

Name
Specify a name for the image.  The default name
is UNTITLED.LP3.

Standard sizes
Select [Letter] to create an 8.5 x 11 image, [11 x
17] to create an 11 x 17 image, [A3] to create a
European legal-sized image, or [A4] to create a
European letter-sized image.

Resolution
Select [200], [240], [300], [480], [600], [1200], or
[1440] dpi resolutions.

Color system
Select the color system for the image you want to
create: [Black & White] or [Full color].
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Format
Select the format of the new image: [.LP3] or
[.BMP].

5. Select the color of your drawing tool:

If you are creating a black and white image,
click on the [FG] button until the desired fore-
ground color displays in the button.

If you are creating a full-color image, click on
the [FG] button to display the Choose Fore-
ground Color dialog box, then double-click on
the desired foreground color.

6. Click on [OK] and use the drawing tools to
create a new image.

Resetting an image

When you reset an image, you clear all edits since the
last save operation.  To reset an image, pull down the
File menu and select [Reset].

Refreshing the screen

If a Windows operation leaves "snow" on the screen,
or you need to refresh the screen for any other rea-
son, pull down the Image menu and select [Refresh
View].   ElixirImage redisplays the image bitmap from
memory onto the screen.

Proof-printing an image

When you are ready to proof print your image, pull
down the File menu and select [Print] or press <Ctrl>
+ <Shift + <F10>.  The Print dialog box displays.
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Figure 2-14.  Print dialog box

The Print dialog box contains the following options:

Printer
Choose your printer as a PCL 4 or compatible, or IBM
4019 printer.

Elixir software has been tested with HP Windows
printer drivers for proof printing.  Other printer drivers
are not supported and may produce unpredictable re-
sults when used with Elixir software.

PCL 4 considerations
PCL 4 printers print a maximum page size of 8 x
10.33 inches.  If the image boundaries fill an 8.5 x 11
inches page, the outer margins of your image will not
print on a PCL 4 printer.

For accurate positioning, shift the print image on the
page using the [Page Shift] option.

Orientation
Select the orientation for your page, [Landscape] or
[Portrait].

Page shift
Select [Page Shift] to shift your proof printer output
horizontally or vertically by the number of dots
specified.

[Xshift] moves your image horizontally and [Yshift]
moves your image vertically.
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Use a negative shift value to shift the printed output to
the left or down, and a positive value to shift your print
output right or up.

For a PCL 4 or compatible printer, the normal or cen-
tered image value is [Xshift] = -60.

Copies
Select the number of copies you want to print.

Use printer resolution
Select this option to print your image using the current
printer resolution.  If you do not select this option, your
image is printed using the image resolution.

Print to file
Select this option to create a print file and save it in
the drive:\ELIXIR\PRINTS\HPPRINT\ directory with a
.PRN extension.  

Autogen output name
When you select the [Print to File] option, the [Auto-
gen Output Name] option also displays.  If  you select
this option, ElixirImage automatically outputs the print
(.PRN) files with the same stem name as the image
(.LP3 or .BMP) file.  If you do not select this option,
the Print To File dialog box displays after you click on
[OK].  Enter the stem name for the file, up to eight
characters.

Additional features

The preceding sections provide a brief overview of
how to use ElixirImage. The following chapters pro-
vide detailed information about all ElixirImage editing
tools and features.

ELIXIRIMAGE BASICS

2-22 ELIXIR TECHNOLOGIES CORPORATION



3.  Displaying and
 drawing an image

This chapter describes how to load and display an im-
age and how to use the drawing tools.

Displaying an image

When you load an image in ElixirImage, the image
displays in the Work area.

Fig 3-1. Displaying an image in the Work area
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The image is bound by a gray, uneditable region.
However, the image can be enlarged to extend into
the gray area as described in the "Additional features"
chapter.

A message displays in the message area, to identify a
loaded file as black-and-white or full color.

Note that the square border around the image is not
part of the image.

View settings

This section describes how to display a magnified
view or a reduced view of an image using the Zoom
icon in the Toolbar.  The Magnification window dis-
plays the current magnification level of an image.

Magnification

Select the up arrow in the Zoom icon (or press the
<+> key on the numeric keypad) to magnify the center
of the image and to display it in a window to the left of
the Work area.  

The magnification factor displays in the Magnification
window.  The default magnification factor is 1x.  Select
the up arrow or press the [+] to display 2x, 4x, 8x, 16x,
and 32x magnifications.

Note that displaying an image at a magnification factor
of 16X or more may cause your system to become
unstable.
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         Figure 3-2.  Magnified view

The magnified area in the left window is defined by the
Locator Box in the right window.  To magnify a differ-
ent area of the image, click inside the Locator Box and
drag it.  To change the color of the Locator Box, see
the "ElixirImage basics" chapter.  Alternatively, you
can use the arrow keys or the scroll bars to move
around and display different portions of the image.

Click on the Grid icon in the Toolbar to toggle on a
grid.  The grid only displays at magnifications of 8x or
higher.

All drawing tools described in the following sections
work in magnified view.
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Reduction/print size

Before building a reduced view of an image, select a
Stretch mode.  Stretch mode affects the way an im-
age displays when it is reduced.  To select a Stretch
mode, pull down the Image menu and select [Stretch
mode].  Select one of the following options:

[Color on Color] preserves black and white
pixels when an image is reduced and is
probably the best mode for performing image
reductions.

[Black on White] preserves black pixels at the
expense of white pixels when an image is
reduced.

[White on Black] preserves white pixels at the
expense of black pixels when an image is
reduced.

To display a reduced view of an image, select the
down arrow in the Zoom icon or press the <-> key on
the numeric keypad.

Initially, the image displays at print size (PRN) which
allows you to preview an image at actual size.

Select the down arrow again to display the image at
-2x, -4x, and -8x reduction factors.

This feature is especially useful when you want to fit a
large image into the Work area.

Note that you cannot edit an image in a reduced view.
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Using the drawing tools

The drawing tools display at the top of the Toolbox
and drawing options display in the Toolbar.

To use a drawing tool, select it from the Toolbox or
from the Tool menu.  In the figure at the left, the Line
tool is highlighted.

You can select options for your drawing tools.  The
drawing tool you select determines the options avail-
able in the Toolbox.  Drawing tool options are de-
scribed in the following sections.

All drawing operations are performed by clicking and
dragging the mouse in the Work area. 

Note that you can use all the tools described in this
section in the magnified view mode described earlier
in this chapter.

FG button

The [FG] button allows you to select the color of a
drawing tool as black, white or a color, depending on
the color mode selected for your image.

If you are creating a black and white image, se-
lect a color by clicking on the [FG] button until it
displays the color you want.

If you are creating a full-color image, select a
color by clicking on the [FG] button and double-
clicking on the color you want in the Choose Fore-
ground Color dialog box.

BG button

The [BG] button allows you to set the background
color when creating a new image, entering text, and
performing some of  the transformation operations de-
scribed in the "Manipulating images and image areas"
chapter.  The [BG] button also allows you to set the
color of a fill when drawing filled shapes, as described
in appropriate sections of this chapter.  

FG

BG
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If you are creating a black and white image,
click on the [BG] button until it displays the
background color you want.

If you are a full-color user, the Choose Back-
ground Color dialog box displays when you
click on the [BG] button.  Double-click on the
color you want to use. 

Pattern button

The currently loaded pattern displays in the Pattern
button.  Click on the Pattern button to display the Pat-
tern window from which you can load the black-and-
white shading patterns described in the "Drawing pat-
terns" section of this chapter.

If you are a full-color user, you can also choose one of
the colors from the full-color palette.  Click on [Full...]
and select a color from the pattern window that
displays.

Note that the [High...] option is not a valid option in
this release of ElixirImage.

GO button

The [GO] button is used to apply the transformation
operations described in the "Manipulating images and
image areas" chapter. 

Border width

The up and down arrows in the Toolbox are used to
set the border width of lines, shapes, brush and pencil
tips, and the eraser.

To set the border width, click on the up arrow to in-
crease the width, or on the down arrow to decrease
the width.  The border width displays in the box next to
the up and down arrows.  

You can also change the current value by backspac-
ing over it and entering a new value.   Alternatively,
you can click once in the numeric display box and se-
lect the lowest border width value by <Ctrl>-clicking in
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the box, or the highest border width value by <Shift>-
clicking in the box.  

Border style

Select [Solid], [Dashed], or [Dotted] borders when
drawing lines or shapes.

Line

The Line tool allows you to draw single, connected, or
radial lines.

Figure 3-3.  Line options

Select from the following options in the Toolbox:

Line direction
Select the line direction as [Horizontal], [Vertical],
[Both], or [Free].

Select [Horizontal] to draw a line in the hori-
zontal direction only.

Select [Vertical] to draw a line in the vertical
direction only.
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Select [Both] to draw a line in the horizontal or
vertical directions, depending on mouse
movement.

Select [Free] to draw a line in any direction,
including diagonal.

The [Horizontal] and [Vertical] options enable you to
draw long lines on large images which do not fit in the
Work area.  If you are drawing connected lines and
want to scroll around the image, the line will stay con-
nected to the last point.  

Line beginning and end style
Select the line beginning (top row) and end style (bot-
tom row) you want.  Select [Square], [Round], or [Mi-
tered] for each end of your line.  Line beginning and
end styles are most apparent at line widths of 10 or
above.

Note that the [Mitered] option is available with diago-
nal lines only.

The following figure illustrates the effects of [Square],
[Round], and [Mitered] ends.

Figure 3-4.  Line end examples

Line style
Select [Single], [Connected], or [Radial].

Select [Single] to draw a single line between
mouse clicks.
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Select [Connected] to connect lines between
successive mouse clicks until you select an-
other line style or drawing tool.

Select [Radial] to create lines that radiate
from a single point.  This option applies to
[Free] direction lines only.

Note that the [Undo] option is not available for radial
lines.

You can change the line properties while drawing a
line.  You can also use different line widths while
drawing a line as shown in the following figure.

Figure 3-5.  Connected lines with different widths

Curve

The Curve tool allows you to draw sections of circles
or ellipses.  Connecting curves together enables you
to produce high quality line art.
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Figure 3-6.  Curve options

Select from the following options in the Toolbox:

Curve type
Select [Quarter Circle] to use sections of circles to
draw curves or select [Quarter Ellipse] to use sections
of ellipses to draw curves.

Curve direction
Select [Horizontal]. [Vertical], or [Any]

Select [Horizontal] to draw the curve
horizontally.

Select [Vertical] to draw the curve vertically.

Select [Any] to draw the curve in any
direction.

Curve style 
Select [Single], [Connected], or [Radial].

Select [Single] to draw curves one at a time.

Select [Connected] to connect curves be-
tween successive mouse clicks until you se-
lect another curve mode or drawing tool.
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Select [Radial] to create curves continuously
from one point.

The following figure shows examples of curves in the
three different modes.

Figure 3-7.  Curve examples

Box

The Box tool allows you to draw hollow or filled
squares or rectangles with squared or rounded cor-
ners.  The width of the box border is determined by
the [Border Width] option.  

Figure 3-8.  Box options
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Select from the following options in the Toolbox:

Box shape
Select to draw a [Square] or [Rectangle].

Box corners
Select [Square] or [Rounded] corners.

Box type
Select [Hollow] or [Filled].  If you select [Filled], the
box fills with the fill pattern displayed in the Pattern
window.

Corner radius
Select [Custom] or [Maximum].

Select [Custom] to set the width and height
dimensions of rounded corners using the up
and down arrows next to the [Width] and
[Height] option.

Select [Maximum] to draw a square or rectan-
gle with rounded corners of equal height and
width dimensions.

The following figure shows examples of boxes.

Figure 3-9.  Box examples

Note that square boxes appear distorted on the
screen when the screen aspect ratio is not 1:1.  How-
ever, these boxes will print correctly.
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Ellipse/Circle

The Hollow or Filled Ellipse/Circle tool allows you to
draw hollow or filled circles and ellipses.  The width of
the border around the circle or ellipse is determined by
the [Border Width] option.

    Figure 3-10.  Ellipse/Circle options

Select from the following options in the Toolbox:

Circle/Ellipse shape
Select to draw a [Circle] or [Ellipse].

Ellipse/Circle origin
Select [Center] or [Box Around].

Select [Center] to draw an ellipse/circle  from
the center outward where the anchor point is
the circle or ellipse center.

Select [Upper left quadrant] to draw an
ellipse/circle that expands outward with one
quadrant of the ellipse/circle remaining an-
chored in the starting position.  This method
allows you to place the shape more precisely
in relation to another object.
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Ellipse/Circle segment
Select one or more of the four segments to display
that segment of a circle or ellipse.  

Ellipse/Circle type
Select [Hollow] or [Filled].  Selecting [Filled] draws cir-
cles and ellipses with the fill pattern displayed in the
Pattern window.

Figure 3-11.  Ellipse and circle examples

Polyline/Polygon

The Polyline tool is useful for drawing polylines, or
filled and unfilled polygons.

To draw a polyline or polygon, move the screen
pointer into the Work area, click in the image to start,
and keep clicking and moving to draw the line seg-
ments of the polyline or polygon.  To end a polyline or
polygon, double-click the left mouse button.  
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Figure 3-12.  Polyline/Polygon options

Select from the following options in the Toolbox:

Polyline/Polygon
Select [Open] or [Closed].

Select [Open] to draw a polyline.

Select [Closed] to draw a polygon.

Polyline/Polygon direction
Select [Horizontal & Vertical] or [Free] line segments.

Select [Horizontal & Vertical] to draw lines
that snap to horizontal or vertical lines.

Select [Free] to draw lines in any direction.

Polygon fill mode
Select [All] or [Alternate].

Select [All] to fill the entire polygon with the
pattern displayed in the Pattern window.

Select [Alternate] to fill only areas that are ac-
cessible from the outside of the polygon by
crossing an odd number of lines.
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           Figure 3-13.  Alternate polyline 

Polyline/Polygon type
Select [Hollow] or [Filled] when drawing a polygon.  

Selecting [Filled] draws polygons with the fill pattern
displayed in the Pattern window.

Note that the border of the polygon is the color se-
lected in the [FG] button.

Figure 3-14.  Polygon examples

Pencil 

The Pencil tool draws a continuous line in black or
white.  Full-color users have the additional option of
drawing in color.  
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Figure 3-15.  Pencil options

Select from the following options in the Toolbox:

Pencil tip
Select [Square] or [Rounded].

Select [Square] to draw individual dots or a
continuous line with squared ends.

Select [Rounded] to draw individual dots or a
continuous line with rounded ends.

For high-precision work in magnified view, you should
use the Pencil tool with a drawing width of 1.

To see the difference between a [Square] and
[Rounded] pencil tip, select a border width of five dots
or more.

Brush

The Brush tool paints continuous square or circular
dots, or a series of horizontal, vertical, or diagonal
lines, depending on the drawing mode you select.
Click and drag the "brush tip" to generate a shape.
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The Brush tool paints in black, white, or the currently-
selected fill pattern.  Full-color users have the addi-
tional option of drawing in color.

Figure 3-16.  Brush options

Select from the following options in the Toolbox:

Basic brush tips
Select [Square] or [Rounded].

Select [Square] to paint continuous square
dots.

Select [Rounded] to paint continuous circular
dots.

Special brush tips
Select [Horizontal], [Vertical], [Diagonal Right], or [Di-
agonal Left].

Select [Horizontal] to paint a series of con-
tinuous horizontal lines.

Select [Vertical] to paint a series of continu-
ous vertical lines.

Select [Diagonal Right] to paint a series of
continuous diagonal lines that slant to the
right.
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Select [Diagonal Left] to paint a series of con-
tinuous diagonal lines that slant to the left.

The following figure is an example of the effect of the
[Horizontal], [Vertical], [Diagonal Right], and [Diagonal
Left] brush tips.

To achieve a continuous painting action, draw slowly
so that brush tips overlap.

         Figure 3-17.  Samples of brush drawing

Brush type
Select [Dots] or [Pattern].

Select [Dots] to paint in black, white or color
dots, depending on the selection in the [FG]
button.

Select [Pattern] to paint with the pattern dis-
played in the Pattern window.

Airbrush 

The Airbrush tool simulates the effect of an airbrush
by "spraying" dots or patterns on the image.

To spray, click and hold the mouse button.
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Figure 3-18.  Airbrush options

Select from the following options in the Toolbox:

Spray type
Select [Dots] or [Pattern].

Select [Dots] to spray black, white or color
dots, depending on the selection in the [FG]
button. 

Select [Pattern] to spray with the pattern dis-
played in the Pattern window.  

Spray size
The [Area Height] and [Area Width] options set the di-
mensions of the spray area (the area in which dots
are randomly sprayed).  You may want to experiment
with thin spray areas (for example, width 6; height: 15
to 99) first.

Use the up and down arrows in the [Area Height] and
[Area Width] boxes to set the size of the spray in dots.
Alternatively, click in the box and type a value.

Spot characteristics
Use the up and down arrows in the [Spot Size] and
[Spot Border] boxes to set values in dots.  Alterna-
tively, click in any of the boxes and type a value.

DISPLAYING AND DRAWING AN IMAGE

3-20 ELIXIR TECHNOLOGIES CORPORATION

Airbrush options



The [Spot Size] sets the size of the spots the
Airbrush sprays.

The [Spot Border] sets the border width of the
spots.  You can use this feature to create
special effects.  For example, try a spot size
of [9] with a border of [1] and paint using a
gray tone pattern.

Figure 3-19.  Airbrushing examples

Floodfill

The Floodfill tool allows you to fill an area bound by
the current foreground color, or fill an area having the
current foreground color.  You can use the current
background color or pattern as floodfill.

Note that this function may not work correctly if Elix-
irImage is running under the Windows 95 operating
system and the image is 64 KB or larger.
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Figure 3-20.  Floodfill options

Select from the following options in the Toolbox:

Floodfill mode
Select [Interior] or [Solid].

Select [Interior] to fill an area bound by the
current foreground color with the current pat-
tern or the background color depending on
your [Floodfill Type] selection. 

Select [Solid] to fill areas having the current
foreground color with the current pattern or
the background color depending on your
[Floodfill Type] selection.

Floodfill type
Select [Color] or [Pattern].

Select [Color] to fill an area with the current
background color displayed in the [BG]
button.

Select [Pattern] to fill an area with the current
pattern.
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The following figure shows the beach flood-filled with
a brick pattern.

     Fig 3-21.  Floodfill example

Note that if an area is already filled, you can replace
that area with another pattern or color only if the area
is defined by a border color that is different from the fill
color or pattern.  

For example, if you have a shape with a color border,
and a black and white pattern fill, you can replace the
black and white pattern with another black and white
pattern, solid black or solid white.  However, if the
shape border is black or white, you can not replace
the black and white pattern because the border color
is the same as the color contained in pattern.

Eraser/Replacer

Use the Eraser tool to clear portions of an image to
white, black, color or the current pattern. 
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Figure 3-22.  Eraser options

Select from the following options in the Toolbox:

Eraser mode
Select [Stretchy Box] or [Moving Box].  

Select [Stretchy Box] to draw a rectangular
box in the Work area.  Press and hold the
mouse button to start drawing the box.  Then,
as you move the mouse, the box stretches
and erases the area contained in the box.

Select [Moving Box] to display a square with
the dimensions set in the [Border Width] op-
tion.  While holding down the mouse button,
drag the pointer. The area covered by the
square is erased.

Eraser direction
If [Moving Box] is selected, select [Horizontal], [Verti-
cal], [Both], or [Free].

Select [Horizontal] to erase in a horizontal di-
rection only.

Select [Vertical] to erase in a vertical direction
only.
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Select [Both] to erase in a horizontal or verti-
cal direction only.

Select [Free] to erase in any direction.

Pixel replacement
Select [All] or [Color Replace].

Select [All] to clear the whole area with the
current background color, or pattern (if the
[Eraser/Replacer Type] option is set to
[Pattern]).

Select [Color Replace] to replace sections
having the current foreground color with the
current background color, or pattern (if the
[Eraser/Replacer Type] option is set to
[Pattern]).

Eraser/Replacer type
Select to [Erase with [BG] Color] or [Erase with
Pattern].

Select [Erase with [BG] color] to erase with
the current background color.

Select [Erase with Pattern] to erase with the
current pattern or color.

Text tool

The Text tool allows you to import clip art images and
to insert text in your images.  Using the Text tool is
described in the "Using text and clip art" chapter.

Transform tool

The Transform tool is used for copying, moving, creat-
ing clip art, and for transforming an image or a
marked image area.  Using the Transform tool is de-
scribed in the "Manipulating images and image areas"
and "Using text and clip art" chapters.
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Drawing modes

You can select the drawing mode options by clicking
on one of the drawing mode icons in the Toolbar.
These options affect all drawing tools.

The three options are (from left to right) [Replace]
(Opaque), [Transparent] and [Reverse].  The following
figure shows the effect of superimposing a filled rec-
tangle using (from top to bottom) the [Replace],
[Transparent], and [Reverse] options.

The drawing modes work for copy operations and all
the drawing tools except the Eraser. 

          Figure 3-23. Drawing modes

In replace (opaque) mode, drawing over another
shape replaces the shape. 

In transparent mode, drawing does not erase any
shapes underneath it. 

In reverse mode, drawing reverses the color of
the shapes underneath it.
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Drawing patterns

Click on the Pattern button to display the Pattern win-
dow.  The Pattern window displays a number of pre-
defined black and white shading patterns.  If you are
creating a full-color image and want to select from the
color palette, click on [Full...].   The Pattern window
displays the full-color palette.

Note that the [High...] option is not a valid option for
this version of ElixirImage.

Placing the cursor over a pattern or color displays the
name in the Pattern Name box.  Select a pattern or
color from the Pattern window by clicking on it.  The
pattern or color displays in the Pattern button and is
available for use with the appropriate drawing tools
described earlier in this chapter.

To close the Pattern window, click on the [Close] but-
ton.  To move the Pattern window, select the Pattern
header and drag the box to the desired location.

Figure 3-24. Pattern window

Editing patterns

To edit the currently selected shading pattern or color,
click on the Pattern button using the right mouse but-
ton.  The Shading Pattern window displays from which
you can edit the current pattern.
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Figure 3-25.  Editing patterns

The right side of the window shows the pattern at nor-
mal magnification.  The left side of the window dis-
plays a magnified image of the pattern bitmap.

The edit area is within an 8 x 8 dot grid at the center
of the magnified bitmap area.

When you edit a shading pattern and save your
changes, the changes are saved to memory only, they
are not saved to your hard disk.  To store the edited
bitmap with other program settings, you can save the
current configuration by pulling down the System
menu and selecting [Save Configuration].

Although you can use all the drawing tools to edit the
pattern bitmap, it is easiest to use the Pencil tool with
a width of [1] for precision editing.

You can also apply the transformation operations de-
scribed in the "Manipulating images and image areas"
chapter to a pattern bitmap.

You change the color that you edit a pattern bitmap by
selecting black, white or a color in the [FG] button. 
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4.  Manipulating images
 and image areas

ElixirImage includes features that allow you to ma-
nipulate (transform) a loaded image or a marked rec-
tangular area within a loaded image.  

You can perform the following transformation opera-
tions on the whole image: move, resize, rotate, mirror,
distort, clear, reverse, shift, halftone, outline, darken,
lighten, filter, or copy to and from the Windows
Clipboard.

You can perform the following transformation opera-
tions on an area in an image: all the above operations
plus moving, copying, and saving marked areas in the
image.  

The import and export functions allow you to create or
use clip art images.  these functions are described in
the "Using text and clip art" chapter.

All the transformation operations described above are
performed using the Transform menu or the Trans-
form toolbox, except copying to and from the Clip-
board which is performed using the Edit menu.
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Figure 4-1.  Select a transformation from the Toolbox or menu

Procedures

To move, copy, transform, cut, paste or save an im-
age area, you must first mark the area.  To do this,
select the Transform tool, and then drag the mouse in
the Work area.  A dashed box displays around the
marked area.  The marked area can then be moved,
copied, transformed, cut, paste or saved using the
procedures described in the subsequent sections of
this chapter.   
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Figure 4-2.  Marking an area

You do not have to mark an area if you are copying,
moving, transforming, cutting, pasting or saving a
whole image.

Moving

When moving a marked area, the area attaches to the
screen pointer allowing you to place it elsewhere on
the image.  A blank space is left in place of the
marked area.

To move an area, click in the marked area (the screen
pointer changes to a hand) and drag the mouse.  Re-
lease the mouse button to place the area in a new lo-
cation.  A blank space is left in place of the marked
area.

Copying

The copy operation allows you to make single or multi-
ple copies leaving the original image or marked area
in place.
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To make a single copy, <Ctrl>-click in the marked
area (the screen pointer changes to a hand) and drag
the mouse.  Release the mouse button to place the
area.

To create multiple copies, repeat the procedure.

Saving

To save a marked area as an Elixir (.LP3) or Bitmap
(.BMP) image, pull down the File menu and select
[Save Area].  The Save Area into Image dialog box
displays allowing you to specify a file name for the
marked area. 

The new image file is written to the
drive:\ELIXIR\PICS\PRINTER directory.

Transforming images and image areas

To transform an image area, select one of the Trans-
form operations described in the following sections.
Click on the [Go] button after marking an area and se-
lecting the desired transformation options.

If you are transforming an entire image,  simply click
on the [Go] button without marking an area.  Alterna-
tively, pull down the Edit menu and choose [Select All]
to outline the entire image and then click on the [Go]
button to apply the transformation.  To deselect the
image, pull down the Edit menu and choose [Unse-
lect] (or press <Ctrl> + <A> to toggle between select-
ing and unselecting an image).

Successively click on the [Go] button to reapply
transformations.

You can also apply all transformations except the
Resize, Clear, and Shift transformations to an image
area "on the fly" while moving or copying the area, by
using the appropriate <Ctrl>-fast key combination.
Note that the current Toolbox option settings for a
transformation are applied when using this method.
See the "Keyboard shortcuts" appendix for a list of the
transformation fast keys you can use "on the fly."
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Resize 

This operation allows you to resize an image or image
area up or down in independent horizontal and vertical
percentages which you specify by clicking on the up or
down arrows in the [% In Horizontal] or [% In Vertical]
options.  Alternatively, click in the box next to the up
and down arrows and enter a new percentage.

Figure 4-3.  Resize options

If you are upsizing image areas, make sure you have
enough space on the right and below the image area
to place the resized area.

Figure 4-4.  Resizing examples
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You can obtain better results (less distortion) by resiz-
ing in one step rather than repeatedly resizing.

Rotate 

This operation allows you to rotate an image or image
area clockwise or counter-clockwise in 90 degree in-
crements, or 180 degrees.

To specify rotation direction, select the [Clockwise],
[Counterclockwise], or [180 degrees] option in the
Toolbox.

Figure 4-5.  Rotating options

If you are rotating image areas, make sure you have
enough space on the right and below the image area,
as the image is rotated into this area.

The following figure shows the effect of rotating in the
[180 degrees] direction. 
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Figure 4-6.  Rotating example

Mirror

This operation allows you to flip an image or image
area in horizontal or vertical directions.

Select the [Horizontal] or [Vertical] option to specify
the direction in which you want the image flipped.

Figure 4-7.  Mirroring options
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The following figure shows horizontal mirroring.

Figure 4-8.  Mirroring examples

Distort

This operation allows you to distort an image or image
area in any direction.

Distortion is specified by direction and number of pix-
els.  If you slant the area 28 pixels to the right, the top
row of the area will be distorted to the right by 28 pix-
els.  Each successive row will be distorted less until
the last row is not distorted at all.

A benefit to this operation is that through combina-
tions of distortions to the right and upward or to the
left and downward, you can perform arbitrary bitmap
rotations.
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Figure 4-9.   Distorting options

The following figure shows an example of distortion.

Figure 4-10.  Distort example
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Clear

This operation allows you to mark an area in the im-
age and then clear that area or the area outside the
marked area to the current background color.

Select [Inside Area] to clear the marked area, or se-
lect [Outside Area] to clear the image outside the
marked area.

Figure 4.11.  Clearing options

If a large image is loaded, only the part of the image
that displays in the current window will be cleared.

The following figure shows the effect of clearing out-
side an image area.
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Figure 4-12.  Clearing outside an area

Reverse

This operation changes all black dots in an image or
marked area to white, and all white dots in the area to
black.

This operation does not require you to set options in
the Toolbox.  Simply click on the [Go] button to per-
form the operation.

Figure 4-13.  Reversing example
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Shift

This operation allows you to precisely move an image
area or the whole image with respect to its borders.

Select a direction to shift using the up, down, left, or
right arrow, and set the number of pixels you want the
image to shift.

Specify whether you want a [Normal] or [Circular] shift.
[Normal] replaces the area that was moved with the
current background color.  [Circular] begins replacing
the area that was moved with a new version of the im-
age with each click of the [Go] button.

Figure 4-26.  Shift options

The following figure shows an example of a circular
shift with the bigcat logo.

Figure 4-14.  Circular shift example
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Halftone

This operation allows you to apply line or shading pat-
terns to whole images or image areas.

You can apply halftoning as horizontal, vertical, and
slanted (45° and 135°) lines, or as a shading pattern.

Select [Lines] when applying lines for halftoning.  The
[Width] and [Separation] options control the width and
frequency of lines on the screen, thus varying the lines
per inch of the halftone. 

The color of the halftoning lines is the current fore-
ground color which you can set by clicking on the [FG]
button.

If using a shading pattern to halftone, select [Pattern]
and load the desired shading pattern as described in
the "Displaying and drawing an image" chapter.  

.

Figure 4-15 .  Halftone options

The following figure shows the effect of applying half-
toning to the individual characters in an image. 

Figure 4-16.  Halftone examples
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You can apply different halftone screens to the same
area repeatedly to achieve different effects.

Outline

This operation enables you to produce an outlined
(hollow) version of an image or image area.

Select the width of the outline from the Toolbox.
.

Figure 4-17.  Outline options

            Figure 4-18.  Outline example

Darken

This operation allows you to darken an image or im-
age area by adding one or more pixels next to existing
pixels in the image.

Select the number of pixels and the direction in which
you want pixels added.  
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Figure 4-19.  Darken options

Figure 4-20.  Darkening examples
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Lighten

This operation allows you to lighten an image or im-
age area.  Each black area in the image or image
area is contracted by the number of pixels and the di-
rection specified in the Toolbox. 

Note that you cannot reverse a lighten operation using
the [Darken] option, however, you can use the [Undo]
option to restore the pre-lightened image.   

Figure 4-21.  Lighten options

Figure 4-22.  Lightening example
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Filter

This operation allows you to apply up to six filtering al-
gorithms to an image or image area.

Figure 4-23.  Filter options

The following figure shows the features you can filter:
sharp corners, hanging or "ragged" dots, and single
bits.  Filtering a sharp corner removes the corner dot.

Figure 4-24.  Filtering
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To clean up rough edges on black and white signa-
tures and logos, apply all six filtering algorithms by se-
lecting each one in the Toolbox.  

The following figure shows the effect of applying all fil-
ters to a halftone image area.  The result is more con-
trast to the image.

Figure 4-25.  Filtering example

Import and Export

The Import and Export transform operations are de-
scribed in the "Using text and clip art" chapter.

Copying to and from the Clipboard

You can copy an image or marked area to and from
the Windows Clipboard by using the Edit menu.

Copying to the Clipboard

When copying to the Windows Clipboard, pull down
the Edit menu and select either [Cut] or [Copy] (or
press <Ctrl> + <X> for [Cut], or <Ctrl> + <C> for
[Copy]).  

Selecting [Cut] leaves a blank space in the
marked area.

MANIPULATING IMAGES AND IMAGE AREAS

4-18 ELIXIR TECHNOLOGIES CORPORATION



Selecting [Copy] places the image on the
Clipboard without changing the original
image.

You can also copy an area to the Windows Clipboard
using the [Copy Screen Area] option.  To use this op-
tion you must have the screen area you want to copy
visible.  Use the [Copy Screen Area] option as follows:

1. Pull down the Edit menu and select [Copy
Screen Area].

The cursor changes to a hand pointer.

2. Place the finger tip of the hand pointer at the
top left corner of the area you want to copy,
and drag the mouse to the bottom right corner
of the area.  

A temporary box is drawn around the area.  

3. Release the mouse button to copy the area to
the Windows Clipboard.

The message "Block copied to Clipboard" dis-
plays in the Message area.

Pasting from the Clipboard

If you want to paste an image to a specific area, you
must first select the Transform icon and mark the area
where you want the image pasted.  

You must also pull down the Edit menu and select a
Paste mode from the Set Paste Mode sub-menu:

Select [Not Clipped] to paste the image in the
marked area at the actual size.  If the image
is larger than the marked area, the image ex-
tends beyond the marked area.

Select [Clipped to Area] to paste the image in
the marked area.  If the image is larger than
the marked area, only part of the image dis-
plays in the marked area.

Select [Fit to Area] to paste the image in a
marked area.  If the image is larger than the
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marked area, the image is reduced so that it
fits in the marked area.

To paste an image from the Clipboard to a marked
area, pull down the Edit menu and select [Paste] (or
press <Ctrl> + <V>).

If you do not mark an area, the image is pasted in the
top left hand corner of the Work area.
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5.   Using text and clip art

This chapter describes the following:

How to enter text into an image.

Using and creating clip art.

How to tile an image into a font.

How to cut and convert an image area  to a char-
acter in a font.

Entering text

ElixirImage allows you to enter text into an image area
using Windows alpha-numeric TrueType fonts, or
Elixir-format fonts.  Note that as ElixirImage is a bit-
mapped image editor, the text can only be edited
while placing it in the image.  Once it is placed, it can
only be edited as a bitmap using the drawing tools de-
scribed in the "Displaying and drawing an image"
chapter.

If you plan to use Elixir-format fonts, make sure they
are installed in the \ELIXIR\FONTS\ELIXIR directory.
Some fonts are installed in this directory during
installation. 

If you are using the Elixir Desktop, you can also gen-
erate Elixir fonts from outline fonts by using the Elixir
Font Factory supplied with the desktop.  See the Elix-
irFont for AFP User Guide for more information about
Elixir fonts and the Elixir Desktop and Converters for
AFP User Guide for information about generating
fonts with the EFont Factory.

You can also use the converters in the Elixir Desktop
to convert AFP-format fonts to Elixir-format fonts for
use in ElixirImage.
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You insert text into an image by entering text from the
keyboard and selecting text properties from the Text
toolbox.

To display the Text toolbox, select the Text tool in the
Toolbox or select [Text] from the Tool menu.  The
Text toolbox displays.

 Figure 5-1.  Text toolbox

The Text toolbox allows you to select text properties
and displays the current Windows or Elixir-format font
in the Font window.

To enter text, click in the Work area.  The Enter New
Text dialog box displays.

Figure 5-2.  Enter New Text dialog box
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Enter characters from the keyboard using the <Back-
space> key or <Delete> key to edit text, and using
<Ctrl> + <Enter> to insert a carriage return (CR).
Click on [OK] to display the text in the image area with
a box around it if you selected [Box Text], or a cross-
hair pointer if you selected [Free Text].  See the
"Specifying text properties" section of this chapter for
a description of the [Box Text] and [Free Text]
options.

When the text displays with a box around it or a cross-
hair pointer next to it, the text is in Blend Text mode.
Blend Text mode allows you to edit the text, and to po-
sition it anywhere in the Work area.

You can also enter characters from the Soft Keyboard
while in Blend Text mode.  Select the Soft Keyboard
to open it, then click on the desired characters.  The
characters display at the end of the text you entered
with the standard keyboard.  Ensure that the box
around your text is large enough to view these addi-
tional characters.

Figure 5-3.  Box and Crosshair pointer

To position the text when in Blend Text mode, move
the cursor inside the box or crosshair pointer until the
cursor changes to a hand; then click and drag the
mouse to move the text, and release the mouse but-
ton to position the text.

Figure 5-4.  Cursor changes to a hand
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To edit the text when in Blend Text mode, move the
cursor inside the box or crosshair pointer until the cur-
sor changes to a hand, then click on the right mouse
button to display the Change Text dialog box.  Edit the
text and click on [OK] to accept your changes.

Once you are sure of where you want your text posi-
tioned, place the text by clicking outside the text block
and selecting [Cancel] from the Enter New Text dialog
box, or by selecting another drawing tool.  Once text is
placed, you can only edit it as a bitmap using the
drawing tools described in the "Displaying and draw-
ing an image" chapter.

Specifying text properties

Specify text properties by selecting the options in the
Text toolbox.

Font type
This option allows you to select  [Windows] to use
Windows fonts (including symbolic fonts such as Wing
Dings), or [Elixir] fonts.  Note that you can only load an
Elixir-format font into ElixirImage if you have a screen
version of the font.  See your Elixir Desktop and Con-
verters for AFP User Guide for information about gen-
erating a screen version of a font.  

To use Windows fonts:

1. Select the [Windows] option.

2. Click on the [Font Selection] button.  

The dialog box that displays depends on the [Use
Elixir Font Selector] option in the Preferences dia-
log box.  See the "ElixirImage basics" chapter for
more information about the Preferences dialog
box.

If the [Use Elixir Font Selector] option is not
selected, the Font dialog box displays allow-
ing you to select a font name, style, size and
script type from the fonts available within
Windows. 
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         Figure 5-5.  Font dialog box

If the [Use Elixir Font Selector] option is se-
lected, the Choose Font dialog box displays
allowing you to select the font name, style,
height and width.

       Figure 5-6.  Choose Font dialog box

3. Select the font you want to use and click on
[OK].

To use Elixir fonts: 

1. Select the [Elixir] option.

The Load Font dialog box displays the Elixir-
format fonts currently available in the
drive:\ELIXIR\FONTS\ELIXIR directory.  
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If an Elixir-format font is already loaded, click on
the [Font Selection] button to display the Load
Font dialog box.  

Note that you cannot load C0 or C1 - C4 fonts,
and you can only load an X0 or X1 - X4 font if you
have a screen version of the font and a PC
mapped version of the font in
drive:\ELIXIR\FONTS\ELIXIR.  You can create a
PC mapped version of a font when importing an
AFP font into Elixir by selecting the [PC Mapped
Font] button in the Font Converter Options dialog
box.  See the Elixir Desktop and Converters User
for AFP User Guide for more information.

The Load Font box also displays ElixirImage clip
art fonts (described later in this chapter).  To
avoid confusion, ElixirImage clip art fonts are pre-
fixed with a caret (^).

2. Select an Elixir-format font and click on [OK]. 

The currently loaded font displays in the Font
window.

You can view an Elixir-format font before entering it in
the Work area by selecting the [Soft Keyboard] option.
The font displays at the correct size in proportion to
the image in a window below the Work area.  Use the
scroll bar or <PgUp> and <PgDn> keys to scroll
through the font.

While in Blend Text mode, you can enter text from the
Soft Keyboard by selecting individual characters.
Note that you cannot enter Null or grayed out charac-
ters in a font.
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Figure 5-7.  Displaying an Elixir font

To close the window, click on the [Soft Keyboard] op-
tion again. 

Text boundaries
Select [Box Text] or [Free Text].

Box text is bound by columns.  If you select the [Box
Text] option, you must also select the [Text Wrap] op-
tion (described later in this section) and define the
column.  

To define a column:

1. Select the [Box Text] and [Wrap Text] option.

2. Click and drag the mouse in the Work area.

A column displays in the Work area.

3. Release the mouse button when the column is
the correct size.

The Enter Text dialog box displays.
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4. Type the text in the Enter Text window and
click on [OK].

The text displays inside the column.

5. To resize the column, click and drag any of
the handles around the box.

[Free Text] is not bound by columns; only by the width
of the image.  

To enter [Free Text]:

1. Click in the Work area.

The Enter Text dialog box displays.

2. Enter text and click on [OK].

The text displays as a continuous text string in the
image area.

Note that you can switch between [Box Text] and
[Free Text] until the text is placed.  However, if the
[Wrap Text] option is deselected when entering free
text, and you toggle to [Box Text], the [Wrap Text] op-
tion is not automatically activated.  To activate the
[Wrap Text] option in this situation, select the [Wrap
Text] option and click inside the column. 

Text Baseline Rotation
Select the text rotation: [Left to right], [Bottom to top],
[Upside down], or [Top to bottom].

Due to Windows limitations, not all fonts can be ro-
tated.  If a font does not rotate, select a different font
and try the rotate operation again.

Text Justification
You can justify text when the [Wrap Text] and [Box
Text] options are selected.  Specify the justification for
each text block: [Left Justified], [Center Justified],
[Right Justified], or [Full Justified].

Text Positioning
When the [Wrap Text] and [Box Text] options are se-
lected, specify the vertical positioning of the boxed
text: [Top], [Center], or [Bottom].

USING TEXT AND CLIP ART
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You can use this option with [Text Justification] and
[Box Text] to place the text in twelve positions within
the box.

Note that this option is not available if you have the
[Box Text] option selected for a Windows font type.

FG and BG buttons
Click on the [FG] button to toggle between entering
black, white or color text.

Click on the [BG] button to toggle between entering
text on a black, white or color background.

Font Selection
Select this option to bring up the Windows or Elixir
font selection boxes, from which you can select a font
to load.

Soft Keyboard
Select this option when an Elixir font is loaded to dis-
play the Elixir font in a window below the Work area.

Wrap Text 
Select this option to toggle between setting [Wrap
Text] on or off.  When you select [Wrap Text], any text
you enter is bound in the box you define in the [Box
Text] option.

Intercharacter Spacing (for Windows fonts only)
Intercharacter spacing allows you to justify text by
adding or deleting spaces between characters.

Enter a value in the [Intercharacter Spacing] option by
using the up and down arrows next to the box, or
clicking in the box and typing a new value.

As you increase the value, the spacing between char-
acters increases.  As you decrease the value, the
spacing between characters decreases. 

Drawing Mode
You can enter text using [Replace], [Transparent] or
[Reverse] mode by selecting the appropriate icon in
the Toolbar.  The following figure shows examples of
entering text in the three drawing modes.

FG

BG
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Figure 5-8.  Entering text in an image

Clip art

ElixirImage clip art is a collection of images stored as
characters in Elixir-format fonts.  You can think of
each font as a "library" of related clip art.  Because the
clip art is an Elixir-format font, you can convert it to
AFP printer format and print the clip art as characters
on the AFP printer.

To avoid confusion with normal fonts, ElixirImage clip
art file names are prefixed with a caret (^).  During in-
stallation, some clip art fonts are written to the \ELIX-
IR\FONTS\ELIXIR directory. 

You can import clip art into your image from an exist-
ing clip art library, or you can create your own clip art
library.  This section describes how to import clips out
of an existing clip art (font) library and place them in
an image.  See the "Converting an image to a font"
section for information about creating your own clip art
library.
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Importing clip art

This section describes how to import clips from an ex-
isting clip art (font) library and place them in an image.

Refer to the following figure when importing a clip art
item into a displayed image.

Figure 5-9.  Importing clip art options

To import a clip art item into a displayed image:

1. Pull down the Transform menu and select
[Import] or select the Import tool in the
Transform toolbox.

2. Click on the [Clip Art Library] button.

3. Click on the [Load] button to display the Load
Clipart Library dialog box with all the
currently-available clip art libraries (fonts) in
the drive:\ELIXIR\FONTS\ELIXIR directory.

4. Select a library to display the first "page" of
clips in the library and click on [OK].

5. Position the cursor over a clip art item until
the clip art cell is highlighted then click the
mouse button.

USING TEXT AND CLIP ART
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The screen pointer changes to a hand.

6. Drag the image to the Work area and release
the mouse button to position the item.  

Just as with text, you can continue positioning the
clip art item until it is placed.

7. Click the mouse outside the clip art item to
place it.

8. Select and position another clip art item or
select another tool.

Figure 5-10.  Placing clip art in an image

The above figure shows how you can create diagrams
using clip art images.

You cannot place a clip art item outside the image. Ar-
eas falling below or to the right of the viewable image
area are discarded.

If you want to cancel the current clip you are dragging,
release the mouse button before the image reaches
the Work area.
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Just as with text, clip art can be added in any of the
three drawing modes.  Select an icon to add clip art in
[Replace], [Transparent], or [Reverse] mode.

You cannot place grayed out or "null" areas in a clip
art library.

Converting an image to a font

ElixirImage allows you to convert all or part of an im-
age into an Elixir-format font.  Using converters in the
Elixir Desktop, you can convert the Elixir-format font to
AFP format and print the font on an AFP printer.

You can convert an image into a font by creating a clip
art library, tiling an image into a font, or creating a font
from image portions.  If you are converting an image
area, you must mark the area first, as described in the
"Manipulating images and image areas" chapter.

To perform any of these operations, you must select
the Transform tool to display the transformation op-
tions in the Toolbox.  The following sections explain
the above procedures in detail.

Creating clip art

Refer to the following figure when creating a clip art
item from an area in existing image.
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Figure 5-11.  Clip Art and Load buttons

You can create a clip art item from an area in an exist-
ing image and save it as a new font or add it to an ex-
isting font.  

To create a clip art item and save it as a new font:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.

2. Click on the [Clip Art Library] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

           Figure 5-12.  Choose Target Font File dialog box

4. Select [Create New Font].

The Create Clipart Library dialog box displays.

5. Enter a file name following the caret (^) and
click on [OK].  
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A font window with a blank character set displays
at the bottom of the screen.

6. Mark an area in the image

7. With the cursor in the marked area, hold down
the <Ctrl> key, press the mouse button, and
drag the image to a blank character cell. 

8. When the cell is highlighted, release the
mouse button to drop the image into the cell. 

9. Click on the [Save] button to save your
changes.

10. Repeat the procedure until your clip art library
is complete.

.

Figure 5-13.  Creating a clip art library

To create a clip art item and add it to an existing font:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.

2. Click on the [Clip Art Library] button.
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3. Click on the [Load] button to display the
Choose Target Font File dialog box.

See Figure 5-12.

4. Select [Load Existing Font].

The Load Clip Art Library dialog box displays 

5. Select a file to display its contents in a
window at the bottom of the screen.

6. With the cursor in the marked area, hold down
the <Ctrl> key, press the mouse button, and
drag the image to a blank character cell.

The image portion you dragged and dropped is
now a character in the clip art library.

Note that if the character cell is not blank, the im-
age will overwrite the existing character in that
font.

7. Click on the [Save] button to save your
changes.

Note that the font/clip art library window at the bottom
of the screen closes when you select another trans-
form option or tool.

Tiling an image 

This feature tiles images into fonts automatically with
the options you choose.  Refer to the following figure
when tiling an image into a font.
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Figure 5-14.  Tiling options

To convert an image or image area into a font using
the tiling feature:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.

2. Click on the [Tile] button.

3. Click on the [Load] button to display the
Create Font dialog box.  Enter a file name in
the box and click on [OK].
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      Figure 5-15.  Create Font dialog box

A window with a blank set of characters displays
at the bottom of the screen.

4. Select [Sequence] or [Size] option from the
Toolbox.

Select [Sequence] to specify the number of
rows and columns you want the image tiled
to.

Select [Size] to specify the width and height of
the tiles.

5. Specify the start position of the first tile in the
font.  The default 65 corresponds to ASCII
upper case A.  

Note that the maximum number of cells in a font
is 255.

6. Place the tiles [Above the Baseline] or [Below
the Baseline] by selecting the appropriate
option in the Toolbox.

7. Mark the area you want to tile to a font. 

If you are tiling the whole image, skip this step.

8. Click on the [Go] button to tile the whole
image or image area into a font.
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The image or image area is tiled into the blank
character cells at the bottom of the screen.

You may need to scroll through the font to display
the first character.

.

Figure 5-16.  Tiling an image into a font

9. Click on the [Save] button to save the new
font.

To recreate the image in the new file, follow the proce-
dures for importing clip art (see the "Importing clip art"
section of this chapter), but click on the [Font] button
instead of the [Clip Art Library] button to select the font
you just created.  

Creating a font from image portions

This operation is similar to creating a clip art library
except that the font created does not start with a caret
(^). This operation is useful if you have a scanned im-
age containing characters and you want to digitize
fonts from the characters in the image.
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Refer to the following figure when creating a font from
image portions.

      Figure 5-17.  Font creation options

You can create a font from image portions and save it
as a new font or add it to an existing font.  

To create a font from image portions and save it as a
new font:

1. Load the image, pull down the Transform
menu and select [Export], or select the
[Export] option in the Transform toolbox.  

2. Click on the [Font] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

             Figure 5-18.  Choose Target Font File dialog box

4. Select [Create new font].

The Create Font dialog box displays.
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5. Enter a file name and click on [OK].  

A font window with a blank character set displays
at the bottom of the screen.

6. Mark an area in the image.

7. With the cursor inside the area, hold down the
<Ctrl> key, press the mouse button and drag
the image to a blank character cell.  

8. When the cell is highlighted, release the
mouse button to drop the image into the cell.

9. Click on the [Save] button to save your
changes.

To create a font from image portions and add it to an
existing font:

1. Load the image, pull down the Transform
menu and select [Export] or select the
[Export] option in the Transform toolbox.  

2. Click on the [Font] button.

3. Click on the [Load] button to display the
Choose Target Font File dialog box.

See Figure 5-18.

4. Click on [Load Existing Font].

The Load Font dialog box displays.

5. Select a file to display its contents in a
window at the bottom of the screen.

6. Mark an area in the image.

7. With the cursor inside the marked area, hold
down the <Ctrl> key, press the mouse button,
and drag the image to a blank character cell. 

The image portion you dragged and dropped is
now a character in the font.

8. Click on the [Save] button to save your
changes.

USING TEXT AND CLIP ART

ELIXIRIMAGE FOR AFP USER GUIDE 5-21



Figure 5-19.  Creating a font from an image
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6.  Additional features

This chapter describes additional features included in
ElixirImage. These features are not directly related to
drawing or manipulating images, but are included to
help you use ElixirImage.

These additional features are:

ruler display
merging an image into another image
expanding or contracting an image
creating a screen version of an image
create an Elixir form which includes the image
splitting an image.

Ruler 

Clicking on the Digital Ruler in the Toolbar toggles the
ruler display on or off.  You can change the unit of
measure for x and y coordinates to inches, centime-
ters (CM), millimeters (MM), or dots by clicking on the
ruler with the right mouse button.

The first box (from left to right) displays the position of
the cursor relative to the top left corner of the Work
area in horizontal (x) and vertical (y) coordinates.  As
you move the cursor down or to the right, the x and y
coordinates increase in value.  As you move the cur-
sor up or to the left, the x and y coordinates decrease
in value.

The second box displays the x and y coordinates of
the current shape (such as a line, box, or circle) rela-
tive to the starting point.  As you move the cursor
down or to the right, the x and y coordinates display a
positive value.  As you move the cursor up or to the
left of the starting point, the x and y coordinates dis-
play a negative value.  
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Merging an image into another image

Merging images involves placing one image inside an-
other currently loaded image.

To merge an image into a currently loaded image:

1. Select the Transform tool and mark the area
where you want to merge the second image
by dragging the mouse around the area.

The area is marked with a dotted line.

2. Pull down the Edit menu and select the Set
Paste Mode sub-menu to select a paste mode.

See the "Pasting from the clipboard" section of
the "Manipulating images and image areas" chap-
ter for a description of different paste modes.

3. Pull down the File menu and select [Merge] to
display the Merge Image dialog box.

   Figure 6-1.  Merge Image dialog box

4. Select the image you want to merge into the
currently loaded image.
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To select from the list of .BMP images, click on
the down arrow in the window at the bottom of the
dialog box and select [.BMP].

The image is placed in the marked area or in the
upper left-hand corner of the loaded image if no
area is marked.   

5. Save your changes into the current file by
pulling down the File menu and selecting
[Save] (or pressing <Ctrl> + <S>), or to a new
file by pulling down the File menu and
selecting [Save as] (or pressing <F7>).

Expanding/contracting an image

To expand or contract an image (in four directions),
pull down the Image menu and select
[Expand/Contract].  The Expand/Contract dialog box
displays.

     Figure 6-2.  Expand/Contract dialog box

In the dialog box there are four boxes (top, bottom,
left, and right) containing <+> and <-> selections for
expand and contract.  Specify the number of dots you
want the image to expand (<+>) or contract (<->), to
or from the top, bottom, left, or right of the image.
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Creating a screen version

This operation creates a new screen version of the
image and allows you to specify different resolutions
for the screen version.  Screen versions are used to
display the image on your monitor and are also used
when you want to display the image in ElixirForm.

To create a new screen version, pull down the Image
menu, select the Extra Operations sub-menu, then
select [Make Screen Version].

Converting an image to a form template

This operation creates an Elixir form that includes the
currently-displayed image.  This is useful if the image
contains drawing elements which you want to use as a
template for creating other forms.

For example, you can scan a form to create a PCX
image, convert the scanned image to Elixir format us-
ing the Elixir Desktop and Converters, edit the image
using ElixirImage, then use this option to convert it to
an Elixir format form.  You can then use the form as a
template in ElixirForm to create a new form.

Note that the form file thus created uses much less
disk space than the scanned image.

To use this feature, pull down the Image menu, select
the Extra Operations sub-menu, then select [Make
Form Template].  A form template with the same stem
name of the image and an .ELX extension is created
and is saved to the current ElixirForm default forms
directory. 
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Breakup image

This operation divides the image into horizontal or ver-
tical strips of equal height and width.  This feature is
useful if you want to break up a large image for easier
handling (for example, to convert to a font or clip art
library).

To breakup an image:

1. Load the image you want to break up. 

2. Pull down the Image menu, select the Extra
Operations sub-menu, then select [Breakup
Image].

The Breakup Image dialog box displays and al-
lows you to specify the number of horizontal or
vertical strips into which you want to split the
image.

                  Figure 6-3.  Breakup Image dialog box

3. Enter the number of horizontal and/or vertical
pieces you want the image split into.

When you click on [OK], images are created with
the stem name PIECEnn in your
drive:\ELIXIR\PICS\PRINTER directory where nn
is the number you entered in the dialog box.
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A.  DOS directories

The following is a list and description of DOS directo-
ries used by Elixir software for graphics-based
operations. 

Elixir software is directory-specific and the software
always searches or writes to the following directories
(on the drive on which Elixir software is installed).

\ELIXIR\PICS\PRINTER
Elixir-format .LP3 images (input and output)

\ELIXIR\PICS\SEGIN
Input AFP .SEG files

\ELIXIR\PICS\SEGOUT
Output AFP .SEG files

\ELIXIR\PICS\PCXIN
Input .PCX files

\ELIXIR\PICS\PCXOUT
Output .PCX files

\ELIXIR\PICS\SCREEN
Screen versions of Elixir images (.LW8)

\ELIXIR\FORMS\ELIXIR\ and subordinate directories
Elixir-format forms (.ELX). The actual directory is set
in ElixirForm as the default forms directory.

\ELIXIR\PICS\TIFFIN
Input TIFF (.TIF) images

\ELIXIR\PICS\TIFFOUT
Output TIFF (.TIF) images

\ELIXIR\FONTS\ELIXIR
Elixir-format fonts and clip art libraries.

\ELIXIR\PICS\BMPIN
Input bitmap (.BMP) images
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\ELIXIR\PICS\BMPOUT
Output bitmap (.BMP) images

DOS DIRECTORIES
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B.  Keyboard shortcuts

The following keyboard shortcuts (fast keys) are avail-
able within ElixirImage. Standard Windows fast keys
are not included in the list.  For information about Win-
dows environment fast keys, see your Windows
documentation.

Numeric display box transform "on the fly" fast keys
are listed separately at the end of this appendix.

Close dialog 
box/menu <Esc>

Copy <Ctrl> + <C>

Cut <Ctrl> + <X>

Delete <Ctrl> + <Del>

Exit <Alt> + <X> or <Alt> + <F4>

Help <F1>

Image attributes <F2>

Load <F8>

New (file) <F9>

Paste <Ctrl> + <V>

Print <Ctrl> + <Shift> + <F10>

Redo <Shift> + <Ctrl> + <Z>

Save <Ctrl> + <S>

Save as <F7>

Select All (toggle) <Ctrl> + <A>

System information <Alt> + <F5>
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Toolbox display 
(toggle) <F10>

Undo <Ctrl> + <Z>

Unselect (toggle) <Ctrl> + <A>

The following fast keys are used for editing numbers
in numeric display boxes  (such as the Tool Width op-
tion).  Numbers are entered from right to left, similar to
a pocket calculator.  For all but the "Select
highest/lowest allowable value" fast keys, you must
first activate edit mode by clicking in the display box.

Delete number 
(set to 0) <Del>

Delete right digit <Bksp>

Edit (toggle) Left click

Finish editing <Enter>

Reset and 
finish editing <Esc>

Set highest 
allowable value<Shift>-click

Set lowest 
allowable value<Ctrl>-click

Undo edits and reset 
to initial <Ctrl>+<Z>

The following fast keys are used for transforming im-
ages or image areas.  All except the Resize, Clear,
and Shift transformations can be applied "on the fly"
(during move or copy operations).

Clear <Ctrl> + <E>

Darken <Ctrl> + <K>

Distort <Ctrl> + <D>

Filter <Ctrl> + <F>

Halftone <Ctrl> + <H>

KEYBOARD SHORTCUTS
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Lighten <Ctrl> + <T>

Mirror <Ctrl> + <M>

Outline <Ctrl> + <L>

Resize <Ctrl> + <R>

Reverse <Ctrl> + <B>

Rotate <Ctrl> + <O>

Shift <Ctrl> + <I> 

KEYBOARD SHORTCUTS
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C. Conversion chart

You can convert images created in ElixirImage to dif-
ferent formats using the Elixir Desktop and Convert-
ers.  The following chart shows the supported
conversions.

ELIXIR Screen PCX TIFF BMP Pseg TILE

ELIXIR --- X X X X
Screen X --- X X X X
PCX X --- X X X
TIFF X X --- X X
BMP X X X --- X
Pseg X X X X ---
TILE X X ---
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 Glossary

baseline
An imaginary line which is used to position a charac-
ter.  Characters may rest on the baseline or extend
above or below it.  Characters are normally positioned
so that their baselines are aligned.  Such characters
are said to be base aligned. 

bitmap
A two-dimensional array of dots which is used to rep-
resent an image.

blend text mode
The mode during text entry in which text entered
through the Enter New Text dialog box displays in the
Work area, and is editable because text entry mode is
still active.  After text entry mode ends, the text be-
comes a permanent part of the image, and cannot be
edited using the keyboard.

cell
An invisible frame surrounding a character whose
width equals the set width and whose height equals
the line spacing of the font.

face name
A unique design for printed letters, such as Press
Roman.

fixed-pitch
The characteristic of a font family whose characters
are all assigned the same horizontal spacing.

font
A complete set of characters of a particular font fam-
ily, size, face name, and orientation.  A font can also
consist of tiles that compose an image, or pieces of
clip art.

font family
A set of fonts with similar design characteristics, usu-
ally including many sizes, typefaces, and orientations. 
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halftoning
The application of line or shading patterns to an image
so it appears textured.

inverse landscape/portrait orientation
Refers to the print direction of images or fonts as
shown in the following figure.

       Figure G-1.  Page and print orientations

mirroring
The rotation of an image so that its top becomes its
bottom or its right becomes its left.

null character
An unprintable character that occupies an unused po-
sition in a font.

pel
A common contraction for "picture element," the
smallest unit addressable by a page printer.  Also re-
ferred to as a "pixel."

pitch
The size (specifically the width) of a fixed-pitch font in
characters per inch.

pixel
The smallest unit of a digitized picture, either on the
screen or printed.  A pixel is sometimes referred to as
a dot.  Image bitmaps are made up of dots or pixels.
The word pixel is a contraction of "picture element."  A
pixel can contain additional information such as color
and can be larger than one bit while still representing
one dot.

Portrait

Inverse Landscape

Inverse
Portrait

La
nd

sc
ap

e

Landscape

P
ortrait

Inverse LandscapeIn
ve

rs
e 

P
or

tr
ai

t

Portrait Page Landscape Page

GLOSSARY

GLOSSARY-2 ELIXIR TECHNOLOGIES CORPORATION



proportional spacing
The characteristic of a font family, each character of
which is assigned its own horizontal spacing.  Propor-
tional space fonts are aesthetically more pleasing and
are easier to read.  The text in this guide is proportion-
ally spaced.

reverse
To switch an image from black on a white background
to white on a black background, or vice versa.

strikeout
To place a line horizontally across a font.

underline
To place a line under text, usually for emphasis (also
called underscore)

GLOSSARY
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A
AFP PSEG, 2-2
airbrush, 3-20
area

clear, 4-10
copying, 4-2, 4-3
darken, 4-15
distort, 4-9
filter, 4-18
halftone, 4-13
lighten, 4-17
mirror, 4-7
move, 4-3
outline, 4-15
resize, 4-5
reverse, 4-11
rotate, 4-6
saving, 4-4
shift, 4-12
transforming, 4-4

B
bit-mapped graphics,
2-1
box, 3-11
brush, 3-18
Bubble Help, 14

C
circle, 3-14
clear, 4-10
clip art, 3-26

creating, 5-14
importing, 5-11

clipboard operations,
4-19
Context sensitive Help,
1-7
conventions, 1-3

display, 1-3
mouse, 1-5
typographical, 12

converting an image to a
font, 5-14

clip art, 5-14
font, 5-14

copying
area, 4-2
Copy Screen Area,
4-20
multiple, 4-3
single, 4-3
whole image, 4-2

creating a font from im-
age portions, 5-20
creating an image, 2-19
curve, 3-9
Customer support

training, 10
customer support, 1-1

D
darken, 4-15
Dialog box Help, 1-7
digital ruler, 2-9
displaying an image, 3-1
distort, 4-9
drawing modes, 2-10,
3-27
drawing patterns, 3-28
drawing tools, 3-5

airbrush, 3-20
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border, 3-7
box, 3-11
brush, 3-18
color, 3-5
curve, 3-9
ellipse/circle, 3-14
eraser, 3-24
line, 3-7
pencil, 3-17
polyline/polygon,
3-15
text/clip art, 3-26
width, 3-6

E
Edit menu, 2-6
editing an image, 2-17
Elixir applications

conventions, 1-3
Help, 14

Elixir environment
ElixirFont, 10, 1-3
ElixirForm, 10

ElixirFont
installation, 1-9

ElixirImage menu bar,
2-5
eraser, 3-24
exiting ElixirImage, 18
expanding/contracting
image, 6-3

F
features, 2-4

ElixirImage menu
bar, 2-5
message area, 2-10
toolbar, 2-9
toolbox, 2-7
Work Area menu
bar, 2-6

File menu, 2-6
filter, 4-18
floodfill, 3-22
font

baseline rotation,
5-9
boundaries, 5-7
Elixir, 5-6
inter-character spac-
ing, 5-10
justification, 5-9
positioning, 5-9
selection, 5-9
windows, 5-5
wrap, 5-9

form template, 6-4

G
Go button, 2-8, 3-6, 4-4
grid, 2-10

color
, 2-10

H
halftone, 4-13
Help, on-line, 14
Help hypergraphics, 16
Help menu, 1-7, 2-6
Help pop-ups and
jumps, 1-7

I
image

create form tem-
plate, 6-4
creating, 2-19
displaying, 3-1
displaying statistics,
2-17
editing, 2-17
expand/contract, 6-3
loading, 2-14
printing, 2-21
reseting, 2-21
saving, 2-17
screen version, 6-4
splitting, 6-5

Image menu, 2-6
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image statistics, 2-17
installation, 1-9
introduction, 1-1

L
lighten, 4-17
line, 3-7
load an image, 2-14

M
magnification, 2-9
marking an area, 4-2
merging an image, 6-2
mirror, 4-7
mouse, 1-5
moving

area, 4-2
whole image, 4-2

moving an area, 4-3

O
outline, 4-15
overview, 2-1

P
paste modes, 4-21
patterns

black-and-white,
3-6, 3-28
editing, 3-28
highlight color, 3-6,
3-28

PCX, 2-2
pencil, 3-17
polyline, 3-15
preferences, 2-11
print preview, 3-4
printing an image, 2-21

Q
Quick Help, 1-7

R
redo, 2-10
reduction, 2-9
refreshing the screen,
2-21
reset, 2-21
resize, 4-5
reverse, 4-11
rotate, 4-6
ruler, 6-1

S
saving

areas, 4-4
images, 2-17

saving an image, 2-17
screen version, creating,
6-4
Select All, 4-4
setting up, 2-11
shift, 4-12
splitting an image, 6-5
start coordinates, 2-9
starting ElixirImage, 1-9
support, customer, 1-1
System menu, 2-5

T
text, 3-26

box, 5-8
displaying Elixir
fonts, 5-7
entry, 5-1
free, 5-8
properties, 5-4

TIFF, 2-2
tiling an image into a
font, 5-17
Tool menu, 2-7
toolbar, 2-9
toolbox, 2-7
Training, 10
transform, 3-26

area, 4-1, 4-4
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ELIXIRIMAGE FOR AFP USER GUIDE INDEX-3



Select All, 4-4
tool, 4-1
Unselect, 4-4
whole image, 4-1,
4-4

Transform menu, 2-7
transform operations

clear, 4-10
darken, 4-15
distort, 4-9
export, 5-15, 5-18,
5-21, 5-22
filter, 4-18
halftone, 4-13
import, 5-11
lighten, 4-17
outline, 4-15
resize, 4-5
reverse, 4-11
rotate, 4-6
shift, 4-12

transform tools
mirror, 4-8

U
undo, 2-10
Unselect, 4-4
using ElixirImage, 2-10

V
vector graphics, 2-1
views

magnified, 3-2
reduced/print size,
3-4

W
Window menu, 2-6
work area, 2-4
work area menu bar, 2-5

Z
zoom, 2-9
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